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Overview

The HardingFPA HD is the newest version of the HardingFPA Broadcast Flash and Pattern Analyser, which
is capable of analysing High Definition (HD, up to 1080i60) material via capture card over SDI and HDMI
connections depending on the capabilities of the installed Capture Card.   It analyses using new Version 3
analysis  algorithms,  which  have  been  designed  specifically  for  HD  standards  and  file  analyses.   For
compatibility  the  software  can  be  switched  to  use  SD  Legacy  Mode,  which  allows  SD  material  to  be
analysed using Version 2.5 analysis algorithms which are the same as in the previous 2.54/2.57 versions of
the HardingFPA, and Version 1.x of the HardingFPA-X and HardingFPA-XL file-based systems.

An additional file-based add-on for the HardingFPA HD is available,  which has the ability to analyse files
from within the HardingFPA HD.  It is compatible with many file formats including MXF, mov and AVI.
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System Requirements

The  HardingFPA  HD  will  run  on  standard  PC  hardware,  with  a  compatible  capture  card  running  either
Windows®  7  (preferred)  or  Windows®  XP.   Windows  Vista  is  not  recommended  for  running  the
HardingFPA  HD.   The  provided  HASP  USB  software  protection  key  will  need  to  be  inserted  into  the
computer for the application to run, as it will not operate without one. 

PLEASE NOTE  that a full-height (but not necessarily full-length) PCIe non-graphics card slot is essential
in order to accommodate the SDI data capture card. Note some computers although offering PCIe slots
are programmed to only accept graphics cards in those slots.

Minimum hardware requirements:

The HardingFPA HD will run on a computer with the following minimum specification:

Intel Core 2 Quad Q9400 (2.66GHz, 1333MHz, 6MB)
Memory : 2048MB (2x1024) 800MHz DDR2 Dual Channel 
Hard Drive : 250GB (7200Rpm) Serial ATAII 3Gb/s
Windows® 7 Professional 32 Bit     
(Note future releases may require additional resources).

Recommended hardware requirements:

Intel Corei7-860 with VT (2.80GHz, 8M)       
Memory: 4GB (2x2048MB) 1333Mhz DDR3 Dual Channel
Hard Drive: 320GB 3.5inch Serial ATA (7,200rpm)  
Windows® 7 Professional 32 Bit 

The software is intended for use on one computer only, and will lock itself to the machine it is running on
(See Licensing).

To  reduce  the  risk  of  dropped  frames  during  capture  (which  causes  the  analysis  to  abort),  it  is
recommended  that  the  main  hard  disk  drive  in  the  computer  is  defragmented  before  running  the
software, as disk buffering and results saving creates significant disk activity.

If running the software under Windows 7, it is recommended that the following services are disabled on
the computer in order to reduce the risk of dropped frames due to unnecessary disk activity:

Windows Search Indexing Service

Volume Shadow Copy Service (VSS)

SPP Notification Service
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The   HardingFPA  HD   optional  file-based  analysis  module  will  analyse  any  movie  file  for  which  the
computer  it  is  installed  on  has  the  codec,  and  will  attempt  to  open  all  files  with  the  following  file
extensions:

*.avi;*.mov;*.mpg;*.mpeg;*.m2v;*.mp4;*.vob;*.wmv;*.mxf;*.flv

QuickTime Codecs are not provided with the  HardingFPA HD; therefore any required codecs will need to
be installed on the computers to be used.  

In general, if the file can be viewed correctly using QuickTime or Windows Media Player on the computer
that the application is running on, then it will be able to be analysed, although the video must fall within
the whitelist for Accepted Video Formats.
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Accepted Video Formats

The HardingFPA HD will accept the following video formats over SDI:

NTSC 720x486i60 – i.e. 720 x 486 pixels interlaced at 60 fields per sec.
NTSC 720x486i50
PAL 720x576i48 
HD 1280x720p50 – i.e. 1280 x 720 pixels progressive at 50 frames per sec. 
HD 1280x720p59.94 
HD 1280x720p60
HD 1920x1080p23.98
HD 1920x1080p24 
HD 1920x1080p25 
HD 1920x1080p29.97 
HD 1920x1080p30 
HD 1920x1080i50 
HD 1920x1080i59.94 
HD 1920x1080i60 
HD 1920x1080p50 
HD 1920x1080p59.94 
HD 1920x1080p60 

The optional file-based analysis module can analyse movie files with the following video formats:

1920x1080p23.98, 1920x1080p24, 1920x1080i24, 1920x1080p25, 1920x1080i25, 1920x1080p29.97,
1920x1080i29.97, 1920x1080p30, 1920x1080p50, 1920x1080i50, 1920x1080i59.94, 1920x1080p60,
1920x1080i60
1440x1080p23.98, 1440x1080p24, 1440x1080i24, 1440x1080p25, 1440x1080i25, 1440x1080p29.97,
1440x1080i29.97, 1440x1080p30, 1440x1080p50, 1440x1080i50, 1440x1080i59.94, 1440x1080p60,
1440x1080i60

1280x720p23.98, 1280x720p24, 1280x720p25, 1280x720p29.97, 1280x720p30, 1280x720p50,
1280x720p59.94, 1280x720p60 
960x720p23.98, 960x720p24, 960x720p25, 960x720p29.97, 960x720p30, 960x720p50, 960x720p59.94,
960x720p60

768x576p25, 768x576i25, 768x576p27.97, 768x576i29.97

702 – 720 x 576p25, 702 – 720 x 576i25
702 – 720 x 486p29.97, 702 – 720 x 486i29.97
702 – 720 x 480p29.97, 702 – 720 x 480i29.97

640x480p29.97, 640x480i29.97
384x288p25, 384x288i25
352x288p25, 352x288i25
320x240p29.97, 320x240i29.97

In SD Legacy Mode, the optional file-based analyser will analyse movies with the following video formats:

702 – 720 x 576p25, 702 – 720 x 576i25
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702 – 720 x 486p29.97, 702 – 720 x 486i29.97
702 – 720 x 480p29.97, 702 – 720 x 480i29.97

352x288p25, 352x288i25
384x288p25, 384x288i25
320x240p29.97, 320x240i29.97
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Capture Cards

The HardingFPA HD is compatible with the following video capture cards.  Support for more cards and
other manufacturers is planned for the future.

 BlackMagic Design Decklink SDI
 BlackMagic Design Decklink HD Extreme 2
 BlackMagic Design Decklink HD Extreme 3
 BlackMagic Design Decklink Studio
 BlackMagic Design Intensity Pro

Only digital formats are currently supported, i.e. SDI and HDMI.
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Licensing

The HardingFPA HD must be licensed with a USB hardware protection key in order to run (see below). 

Once it  has been run on a  particular computer,  it  will  only  be allowed to  run  on  that  same computer,
although there is limited scope for de-registering the product to move it to another computer (once per
week).

On first run, you will be asked if you wish to lock the software now:

Reregistering

If you move the USB protection key to a new computer and run the HardingFPA HD, you will be given the
option  to  transfer  the  licence  to  the  new  computer,  as  long  as  one  week  has  passed  since  the  last
re-registration / first registration.  The re-registration screen is shown below:
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Only  one  re-registration  is  possible  in  a  week  long  period,  so  be  certain  that  you  wish  to  move  the
licence to the new computer, otherwise you will see the dialogue box below:
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Installation

Before continuing, note that the HardingFPA HD software locks itself to the current
machine, but can be moved once per week.

The HardingFPA HD requires the QuickTime framework in order to operate, which can be obtained from:

http://www.apple.com/quicktime/download/

Once  this  is  installed,  the  drivers  for  your  capture  card  must  be  installed.   This  may  ask  you  to  install
unsigned drivers, in which case, click on “Continue Anyway” each time.  The computer will also need to be
restarted in order for the driver installation to complete.  If you are upgrading from previous versions of
the Decklink drivers, you will need to uninstall the old ones and restart  first.

To install the HardingFPA HD, simply run the HardingFPA HD Setup installer.  

The application will be installed in the HardingFPA section of the Start Menu as "HardingFPA HD".

 

http://www.apple.com/quicktime/download/
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Main Screen

Upon running the HardingFPA HD, the main screen will be displayed.  This is the main and only screen for
the HardingFPA HD and is shown below.  

It displays a graphical representation of the characteristics of the analysed material,  and some additional
advanced diagnostic information, so that the user may quickly and efficiently view the locations of
failures or cautions in the source material, and optionally play back the areas around these failures to aid
in rectifying the offending material.  Its appearance is similar to both the HardingFPA-XL and
HardingFPA-X Viewer applications.

All functionality of the HardingFPA HD is performed from this screen.

The main HardingFPA HD screen

 All of the buttons and sections of the HardingFPA HD screen have help text associated with them.  To see
what a particular part of the interface does, simply hover the mouse cursor over the button/section.
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Version 3 Analysis Algorithms

The HardingFPA HD now features new analysis algorithms, which are better tuned to High Definition and
File-based work.  They are better suited to subtle changes in the image data, and provide much closer
results when testing the same material repurposed either into a different video format, or encoded with a
different codec.  The main differences between the legacy algorithms and the new ones are detailed
below:

Differences Between v2.5 and v3.0 

Different Graph Scaling

The HardingFPA HD generates risk values using the same range as its predecessor (i.e.  0 to 3.4) but
displays the graphical data using a revised vertical scale. This modified scale allocates much more vertical
space for risk trace warnings and diagnostic trace steps but only displays risk traces up to the value of 3.0.
Risk traces values from 3.1 to 3.4 are still logged as part of the results files but are graphically displayed
capped at 3.0.

(left) Version 2 and (right) Version 3 Graphing

The Squiggle

The HardingFPA HD gives enhanced visual diagnostics when an incoming transition coincides with an
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outgoing transition from one exactly second earlier. The new version 3 algorithms insert a squiggle (see
below) to indicate when the diagnostic trace has simultaneously gained and lost a transition over the
most recent second between video frames.

Scene Changes (Japanese NAB Analysis only)

When analysing under Japanese NAB guidelines, it is possible for the flash risk trace to go into failure
while the diagnostic trace is still in the caution zone (see image). T his can occur if one of the transitions in
the most recent second is classified as a “scene change” (see bottom entry of the Advanced Information
tab) where 80% of the image has seen a significant luminance transition of 20IRE units or more. When
this occurs, the maximum allowable number of transitions is reduced from 6 down to 3 and, in this
example, failure took place when the 4th transition was detected.
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Analysis Results

The HardingFPA HD gives results which are broadly similar to those generated by version 2.5.  The figure
below shows the results of both versions when analysing the same video input under the same
guidelines:



18

 © 2010 Cambridge Research Systems Ltd.

HardingFPA HD User's Manual

However, the results between the two versions will not be identical. The HardingFPA HD will, in general,
be more lenient to complex, rapid motion:

... but more strict to examples of powerful, localised flashing:
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Most importantly of all, the HardingFPA HD  has been designed to be as format-agnostic as possible.
Changes in file formats or codecs will alter the underlying video data even if these changes are not
visually apparent. Here, the same video has been encoded at the same resolution using two different
codecs.  The absolute differences between the two images are shown in the third image as deviations
from mid grey. 

The new version 3 algorithms generate highly consistent results from different image resolutions and
frame rates.  Here, the same movie has been analysed in 720x576i50 and 640x480i60 formats with highly
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consistent results. The only noticeable difference is the different horizontal graph scales as a result of the
different frame rates.

The  graph  below  shows  three  sets  of  luminance  flash  risk  results  of  the  same  movie  analysed  in
SD-576i50,  HD-720p50  and HD-1080i50  formats.   The results  are sufficiently similar  it  is  difficult  to  see
that the graph contains three separate traces:
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Operation

The next subsections detail the operation of the HardingFPA HD software, including new features such as
Frame Masks.
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Opening a Source

The HardingFPA HD operates on a system of "Sources", whereby a source (which can be either a video
feed from a tape machine, or (optionally) a movie file) can be opened, and is only analysed when the
analyse button on the main window is clicked (movie files are automatically analysed once they are
opened).  The currently opened source is always displayed below the controls on the main window, and
on startup displays "Current Source: None" to depict the fact that no video source has yet been opened.
To open a new source, click the "Open New Source" button, shown below.

Clicking on the "Open New Source" button brings up the dialogue box shown below, where you can
choose which source to analyse from and may enter additional information in the form of the "Material
Description",  that you require to appear on the PDF certificate or embedded into the results files that will
be created from the analysis.

To open a feed from a capture card, select the tab with the name of your capture card and choose from
the input options and video formats.  A number of timecode sources are supported, although in order to
use LTC, a working RS422 connection to a tape deck must be established.  If you expect to see an input
connection or video format that is not displayed, then check in the Administrator tab of the Settings that
the option has been enabled.

If you have the optional file-based module enabled, you can select a movie file in the "Movie File" tab  by
clicking on the small button labelled "..", or choose a recently selected movie file from the drop-down
menu box.  If you would like to clear this list at any time, click the "Clear List" button underneath.
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When ready to analyse the source, click OK and the "Current Source" notification on the main window will
change to reflect the chosen source, and if Movie File was selected, the analysis will automatically start.
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RS422 Tape Deck Control

If the settings for Tape Deck Control are correctly configured and communications with the tape deck are
established, the tape control interface to the right of the Analysis Controls can be used to control the
attached tape deck (through a serial port via RS422).

These can then be used to cue the tape to the correct point before the analysis starts.  From left to right
and top to bottom these are:

Rewind, Play, Stop, Fast forward,
Jog Back, Jog Forward and Shuttle (variable speed forward and back).
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Analysing a Source

To start analysing the current source, click the "Start Analysis" button in the Analysis Controls section, on
the left, shown below...

Once the source is analysing the screen will appear similar to that shown below, and the Open New
Source button will change to a Stop Analysis button:

Whilst the analysis is being performed the small red LED light in the Analysis Controls will flash to let you
know that a video source is still being analysed.

To stop the analysis, click the Stop Analysis button (the big blue square in the Analysis Controls panel).
When analysing a tape feed, this may only stop the capture, and the analysis will continue - if the disk
buffer (timecode in brackets under Analysis Timecode) has some frames  left in it.  To cancel the analysis
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of these residual frames, press the Stop Analysis button a second time.  Alternatively, wait for these
frames to complete.
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Autosaving

If the options are set in Autosave Options, the HardingFPA HD will automatically save out results files
using those configurable options to the folder specified, ready to be viewed again (See Opening a Saved
Analysis).

 



28

 © 2010 Cambridge Research Systems Ltd.

HardingFPA HD User's Manual

Saving an Analysis

When results are loaded into the software, either from just performing an analysis or by loading results
from another results file, these results can be saved out again with different options by clicking on File ->
Save Results As.  The same options are available as in the Autosave Options. 

Note however that if the currently loaded results set does not have all images, then selecting All Images
will only be able to save images where they exist on the currently loaded results.
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Opening a Saved Analysis

To open previously saved results, click on the "Open results file" button underneath the graph ( ) or
click on the File -> Open results file menu.  The following screen will then appear, showing all of the
metadata attached to the results files in the currently configured results folder.  To change the folder

contents displayed in the table, click the  button and select the new folder.
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Replay Functions

With results displayed in the graph window, the clip and graph can be played back to aid the rectification
of problem areas in the clip.  The Graph Controls panel underneath the graph contains buttons to
facilitate this replay functionality.

From left to right, the buttons perform the following function...

Start Replay:  Starts playback in real-time from the current position.

Stop Replay: Stops all playback.

Replay one second before and after current cursor position:  Animate the images for one second before
and one second after the current cursor position whilst leaving the graph positioned at the current cursor
position.  this is especially useful when you are looking for the causes of a particular failure and need to
look at the graph in detail and yet still see the offending section being played back.

Replay marked region: Replays from the Start marker to the End Marker.  Set marker positions by either
right-clicking on the graph or pressing the Page Up and Page Down keys.

Zoom Out:  Zoom the graph out.

Zoom In:  Zoom the graph in to see the results more clearly.

In all playback modes, the playback will loop when reaching the end (after a small pause).  The playback
can be  stopped at  any  time with  the  Stop Playback  menu item or  button,  by  clicking  anywhere  on  the
graph, by dragging the seek slider or by opening a new file.
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Frame Masks

The HardingFPA HD includes new visual information in addition to the results images in the form of
 Frame Masks. These mask images are overlaid on top of the frame images on the large image in
the top-left of the main screen and depict the locations of problem areas in the sequence, to aid
in the repair  of  failing  sequences.    This  mask  information will  only  be  available  once  the  analysis  is

either complete or stopped, and not whilst the analysis is still taking place.

When the results first appear on the graph, the large image in the top left hand side will appear
as usual.  In order to utilise the frame mask images,  Click on the Frame Mask menu, and select
the type of failure that you want to see the mask overlaid for:

When any of the frame masks are chosen from this box, the images will change and the mask will
be overlaid onto a darkened, black-and-white (monochrome) version of the original frame
image. An example is shown below:

The colours represent the number of transitions which each pixel has experienced in the most
recent second after allowing for motion. The analyser will issue a failure when more than one
quarter of the image contains red or purple pixels. The same colour coding (shown below) is
used for both luminance and red flash analysis.

Pixel Colour Number of Transitions

none 0

green 1 or 2

yellow  3 or 4  

orange 5 or 6
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red 7 or 8

purple 9 or more

The spatial pattern mask data logs the activity which exceeds the spatial guideline limits as
shown below. 

The mask data appears as a set of uniformly coloured tiles in the image which represent how
long they have persisted in the image sequence. Spatial mask data only appears for stationary,
regular patterns which lead to failure. Any spatial patterns which drift, or are not regular, or do
not persist in the video long enough to trigger a failure are excluded. 

Pixel Colour Persistence

none no regular stationary pattern present

green 0 to 1/6 second

yellow  1/6 to 1/3 second

orange 1/3 to 1/2 second

red more than 1/2 second = FAILURE

purple outside of pattern regularity limit

The actual colours used represent how close the spatial pattern is to causing a failure rated in
terms of how long the pattern has persisted in the image sequence. When running under Ofcom
guidelines, the HardingFPA HD analyser will only tolerate illegal spatial patterns to persist for up
to half a second -- any longer than this will lead to a failure. Therefore the green, yellow and
orange colours denote the build up to failure while red represents the actual failure itself. Purple
is reserved for tiles which are part of the detected spatial pattern but whose pattern
characteristics lie outside of the allowable range when compared with the rest of the spatial
region. These purple tiles do not represent persistence and can accompany spatial masks of any
colour. 
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It is important to note that the HardingFPA HD only presents mask colours for pixels which will
go into failure within the next second.  This allows the editor to focus on the region(s) of the
image which lead to the failure rather than flooding the user with unnecessary information. As a
result, many images will contain no masked / coloured pixels even though there may be some
flash or pattern activity occurring. 

In addition, pixel mask activity may suddenly disappear after an isolated failure sequence if the
remaining pixel transition activity does not lead to a subsequent failure. 
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Analysis Information

The  table  on  the  left  hand  side  of  the  screen  contains  two  tabs  which  display  diagnostic  information
about the clip.  The Analysis Summary tab shows the following pieces of information, which are applicable
to the entire clip:

The HardingFPA HD’s Analysis Summary tab

Status:  Shows  whether  the  HardingFPA  HD  is  reviewing  results  or  in  another  state  such  as
loading/results/analysing/not loaded etc.

Video Source: The video standard of the analysis being viewed.

Filename:  The  filename  or  title  of  the  source  that  was  analysed  to  obtain  the  results  currently  being
displayed.

Analysis  Timecode:  The  timecode  of  the  final  frame  in  the  clip.  This  is  expressed  in  hours  :  minutes  :
seconds  :  frames.  The  timecode  in  brackets  is  the  amount  of   video  stored  in  the  disk  buffer  spoolfile
waiting to be analysed.

Marked  Length:  The  length  of  material  currently  marked  off  with  Begin  and  End  markers.  This  is
expressed in hours : minutes : seconds : frames.

Recorded Length: The total length of the clip expressed in hours : minutes : seconds : frames.

Analysis Status: The Pass / Fail status of the clip with respect to the currently selected Flash and Pattern
guidelines.

Red Flash: The number of frames that exceed the test guidelines for red flash.

Spatial Patterns:  The number of frames that have exceeded the test guidelines for spatial patterns.

Luminance Flash: The number of frames that have exceeded the test guidelines for luminance flash.
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Extended  Failure:  The  number  of  frames  that  exceed  the  test  guidelines  for  extended  failure.  This
represents the number of frames for which the black trace has appeared or equivalently, the number of
times  that  the  maximum  allowed  number  of  flash  warnings  (levels  0.3  or  0.4)  in  the  most  recent  5
seconds has been exceeded.

In addition to this information, there is a second tab featuring Advanced Information.   This tab contains
detailed information corresponding to the individual frame at the current cursor position, and may be of
use in determining the build up to a failure.  The items described are as follows:

The Advanced Information tab

Luminance Diagnostic: This is the numerical value of the diagnostic plot shown on the graph. It represents
the minimum number of transitions which the most active 25% of the image frame has seen in the most
recent second.

Luminance Flash Area: The percentage area of the image frame which has exceeded the Flash Guidelines. 

Luminance Flash Contrast: The average contrast of the area of the image frame which has exceeded the
Flash Guidelines.

Extended Flash Warnings: The number of image frames which have generated flash warnings (levels 0.3
or 0.4) in the most recent 5 seconds.

Red Diagnostic: The number of red transitions which the most active 25% of the image frame has seen in
the most recent second.

Red Flash Area: The percentage area of the image frame which has exceeded the Red Flash Guidelines.

Red Flash Contrast:  The average amplitude of flash to  and from saturated red of  the area of  the image
frame which has exceeded the Red Flash Guidelines.

Spatial  Pattern  Area:  The  percentage  area  of  the  image  frame  which  has  exceeded  the  Spatial  Pattern
Guidelines.

Spatial  Pattern Contrast:  The average contrast  of  the area of  the  image frame which has  exceeded the
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Spatial Pattern Guidelines.
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Settings

The settings for the HardingFPA HD can all be found by clicking on Tools -> Settings on the main screen. 
The settings are seperated into tabs, and the final tab (Administrator) is only shown if you are running the
application as an administrator user within Windows, and features administrative settings.
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Video Capture

These are the settings relating to the tape-based capturing of video feeds via a Capture Card.

The Spoolfile in this case refers to the hard drive buffer that is used to store frames from the incoming
video feed before they are passed to the analysis engine.

Spoolfile Location is the filename of the spoolfile on disk.  For best performance when analysing High
Definition material, it is preferable to have this file on a different physical disk to the Autosave location.
Max. Size is the maximum size of the circular spoolfile buffer.  This is generally best left at the default
value of 1024 Mb (1 Gb), but if problems occur with dropped frames, this may be modified to alter the
performance of the buffering scheme.
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Autosave Options

These are the settings relating to the Autosave feature, in which a results set is automatically saved
during analysis. It specifies the location of the autosaved PAP/PAR/PAM files (results files used by the 
HardingFPA HD to display graph and mask data).

Here there are also the options of when to save images in the results files, which can be selected as a
compromise between hard disk space and number of images saved.  Images can be saved a configurable
number of seconds around failures, and images can be omitted if the material passes (by checking the box
"Only if material fails").
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PDF Certificate Options

These are the settings relating to the generation of HardingFPA PDF certificates.

PDF Detail refers to how verbose the PDF is to be:

Include Cautions will include data for regions of the analysis which are in the Caution range, as well as the
Fail range.
Detailed Results controls whether or not the PDF is to include data during failures. Without this being
selected, only the beginnings and ends of  failing regions are included in the PDF.

PDF Images controls the frame previews in the PDF:

Show Frame Thumbnails selects whether or not to include images in the PDFs.
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Display

These are the settings relating to the display of video frames in the interface.

Live Thumbnail controls options relating to the smaller thumbnail image that displays the current live
captured image from the Capture Card in tape mode:

Enable Live Thumbnail window popout (Double-Click) allows the small live thumbnail to be double-clicked
to enable a pop-out hardware accelerated, resizable window.
Enable Full Screen Live Thumbnail (Single click on expanded window) allows the popped out window to be
clicked and enter full-screen mode.
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Tape Deck Control

These are the settings relating to the remote control of a tape deck through the serial port using the
RS422 protocol.

RS422 Interface details the settings for the connection to the tape deck:

Enable RS422 Deck Controls will enable this communication when checked.
RS422 Port defines the COM port (Serial) that the deck is connected to.

Note that correct communications must be established with the tape deck if you would like to use LTC
timecodes.
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Administrator

These are the administrator's settings that only appear when the application is being run as a Windows
administrator user (i.e. one with write permissions to the HKEY_LOCAL_MACHINE registry).

Allowed Source Options provides a way for administrators to whitelist the connections and standards that
will be provided to the users.  Use the arrow buttons to move the options between the Disallowed and
Allowed lists.

Analysis Options provides options relating to the actual analysis of video content:

Use SD Legacy Mode switches on SD Legacy Mode.
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SD Legacy Mode

The HardingFPA HD  has a version 2.5 legacy option for when comparisons with earlier HardingFPA
analyses are necessary.  To select legacy mode, select the Settings option on the Tools menu (as a
Windows administrator user, so that the Administrator settings tab is visible), check the box to enable SD
Legacy Mode, and then close and restart the HardingFPA HD application.  Please note, Legacy Mode is
only available for Standard Definition (SD) video analysis.  All HD formats will be analysed with Version 3
analysis algorithms.  Once the application is restarted, the HardingFPA HD will only analyse in legacy
mode unless the above change is reversed. The HardingFPA HD will indicate legacy mode analysis both in
the graph and on any PDF results certificate (see below).
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Interpreting Results

1) A flash occurred but the normal flash risk trace didn’t appear – The main flash risk trace (dark green
line)  may not  appear if  flashing is  less  than 20cd/m2  in contrast  or  if  the  flash  frequency is  significantly
within guideline limits. Remember that 2 opposing transitions make up a single flash.

The example below shows that  two transitions have been detected by the diagnostic  trace  (light  green
line) but that the main risk trace has not yet appeared because the flash frequency up to this point is not
considered to be significant.

(1) Showing a flash but no flash risk trace
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2)  The  flash  risk  trace  (dark  green  line)  appeared  close  to  the  pass-fail  limit  for  a  long  sequence  of
images but didn’t enter the fail  zone  –  The system has detected flashing of  above 3Hz and 20cd/m2  in
amplitude; but the flash area is less than 25% of the screen area.  If the criteria for failure are not all met
then the system will generate a line based on how close the material is to failure.  If the line is hovering
just below the failure line then it might only need a tiny change in size of the flashing area to push it into
failure.  Such a tiny change could be introduced when converting between formats, frame rates or codecs
if this is not done carefully using professional grade codecs.

The example  below shows that  the  flash  risk  has  remained  close  to  the  failure  line  for  long  enough  to
generate an extended flash  failure.  This  occurs  whenever  more  than 80% of  the  frames  in  the  last  five
seconds generated flash risk warnings of 0.3 or 0.4 (i.e. close to failure).

(2) Long sequence of flashing that eventually led to an Extended Flash Failure
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3)  The  flash  risk  trace  (dark  green  line)  persists  for  several  frames  after  a  flash  occurred  –  This  is
perfectly normal,  and arises because of the way the system has to  detect  flashing frequencies over  the
most recent second.  You do not need to worry about the persistence of the flash risk traces, you need to
principally examine the second before the line moves into failure, or where the diagnostics trace shows
that the transition count is still rising.  Once you have corrected all the causes of the line first moving into
failure  then  the  material  at  that  point  will  pass  the  test.   Note,  however  that  lots  of  flashing  close
together will generate a much longer compound failure: the best thing to do is deal with the flashes one
at a time until the material passes the test.

(3) Flash graph persisting after the flash.
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4) The diagnostic transition count increased where no obvious flash had occurred – The diagnostic trace
represents  the  number  of  transitions  seen by  the  most  active  25%  of  the  screen  over  the  most  recent
second. Therefore continuous image activity (e.g. localised flashing and rapid movement within the scene
caused by camera pan or zoom etc) can steadily increase the number of transitions that individual pixels
have  seen,  and  when  at  least  25%  of  those  have  seen  an  extra  transition  will  the  diagnostic  count
increase. This can be quite tricky material to fix, and may only be possible by reducing the brightness of
the image or cut down on the whole area.

(4) Transition count (light green trace) increased without an obvious transition
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5) A flash clearly occurred but the diagnostic trace didn’t increase – The diagnostic trace shows the
number of transitions seen in the last second of material, and transitions older than that will be
discarded. This means that the diagnostic count may not always coincide with an obvious flash.  For
example, a visible transition in an image may not lead to a higher transition count if the pixels that see the
transition are not part of the most active 25%. 

(5) A flash clearly occurred but the diagnostic trace hasn’t increased.

Alternatively,  an incoming transition may coincide with an outgoing  transition from one exactly  second
earlier. When this occurs, the new version 3 analyser inserts a squiggle (see picture with inset) to indicate
that  the  diagnostic  trace  has  simultaneously  gained  and  lost  a  transition  over  the  most  recent  second
between video frames. 
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6) The spatial pattern trace remains in the pass zone even though the detected spatial pattern exceeds
contrast and screen area limits – A number of limits have to be exceeded before a detected spatial
pattern can generate a failure. The Advanced Information tab in the example below shows that a spatial
pattern has been detected with 50 cd/m2 contrast (limit 20 cd/m2) and covers 46% screen area (limit
40%). However, in this example, the system has not generated a failure because motion, caused by the
camera pan and zoom, makes the detected spatial pattern exempt from failure under Ofcom rules.
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7)  The diagnostic  trace decreased within a few frames after  it  had increased.  Shouldn’t  it  have taken
one  second  for  the  transition  to  flush  out?   --  Not  necessarily.   It  is  true  that  the  diagnostic  trace
monitors  transitions  over  the  most  recent  second  but  the  most  active  pixels  that  determine  this
diagnostic  count  are,  in  most  cases,  constantly  changing.  The  diagnostic  trace  will  only  follow  this
one-second pattern if the most active pixels are changing together in phase.

The example below shows the diagnostic trace (light green) increasing from zero to one for a period of
only two frames (around the vertical amber current frame line) before returning to zero.
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8)  The system passes a stationary pattern that looks as  though it  should have failed  –  Some patterns
that  are  clearly  bar-like  in  one  direction  may  also  possess  some  local  structure  in  the  orthogonal
direction.   Alternatively,  a  pattern  may  not  be  sufficiently  regular  or  may  not  have  sufficient  contrast
throughout. Any such structure may cause the system to see fewer than 6 light-dark bars or may separate
a  provocative  pattern  into  two  or  more  regions.  Either  of  these  mechanisms  can  save  a  provocative
pattern that would otherwise have failed.

The spatial pattern in the example below passes because of text and foreground objects which break up
the bar-like pattern into smaller irregular regions. 
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9) The analyser generates spatial warnings but it’s not obvious where the pattern is! – Occasionally the
spatial  trace  may  appear  when  there  is  no  obvious  spatial  pattern  present  in  the  video  stream.  The
example  below shows a  picture  of  the  sea  generating  spatial  warnings  caused  by  waves  in  perspective
creating  faint,  repeating  structure.  Other  candidates  for  generating  unexpected  spatial  responses  are:
landscape in perspective, net curtains and reams of paper. However, it is highly unlikely that any of these
scenes would actually lead to a spatial pattern failure.
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Licensing Information

The HardingFPA HD  uses the Silk icon set from http://www.famfamfam.com/lab/icons/silk/

Some HardingFPA HD plugins use external libraries and make use of the following persons' or companies'
code:

FFmpeg:  Copyright (c) 2000-2009 Fabrice Bellard, et al.  

http://www.ffmpeg.org/

FFmpeg is licensed under the GNU Lesser General Public Licence, which is duplicated below.  

The build instructions and source code for the FFmpeg libraries used in this product are included on the
installation media.

  GNU LESSER GENERAL PUBLIC LICENSE

       Version 2.1, February 1999

 Copyright (C) 1991, 1999 Free Software Foundation, Inc.

 51 Franklin Street, Fifth Floor, Boston, MA  02110-1301  USA

 Everyone is permitted to copy and distribute verbatim copies

 of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL.  It also counts

 as the successor of the GNU Library Public License, version 2, hence

 the version number 2.1.]

    Preamble

  The licenses for most software are designed to take away your

http://www.famfamfam.com/lab/icons/silk/
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freedom to share and change it.  By contrast, the GNU General Public

Licenses are intended to guarantee your freedom to share and change

free software--to make sure the software is free for all its users.

  This license, the Lesser General Public License, applies to some

specially designated software packages--typically libraries--of the

Free Software Foundation and other authors who decide to use it.  You

can use it too, but we suggest you first think carefully about whether

this license or the ordinary General Public License is the better

strategy to use in any particular case, based on the explanations below.

  When we speak of free software, we are referring to freedom of use,

not price.  Our General Public Licenses are designed to make sure that

you have the freedom to distribute copies of free software (and charge

for this service if you wish); that you receive source code or can get

it if you want it; that you can change the software and use pieces of

it in new free programs; and that you are informed that you can do

these things.

  To protect your rights, we need to make restrictions that forbid

distributors to deny you these rights or to ask you to surrender these

rights.  These restrictions translate to certain responsibilities for

you if you distribute copies of the library or if you modify it.

  For example, if you distribute copies of the library, whether gratis

or for a fee, you must give the recipients all the rights that we gave

you.  You must make sure that they, too, receive or can get the source

code.  If you link other code with the library, you must provide



57

 © 2010 Cambridge Research Systems Ltd.

HardingFPA HD User's Manual

complete object files to the recipients, so that they can relink them

with the library after making changes to the library and recompiling

it.  And you must show them these terms so they know their rights.

  We protect your rights with a two-step method: (1) we copyright the

library, and (2) we offer you this license, which gives you legal

permission to copy, distribute and/or modify the library.

  To protect each distributor, we want to make it very clear that

there is no warranty for the free library.  Also, if the library is

modified by someone else and passed on, the recipients should know

that what they have is not the original version, so that the original

author's reputation will not be affected by problems that might be

introduced by others.
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  Finally, software patents pose a constant threat to the existence of

any free program.  We wish to make sure that a company cannot

effectively restrict the users of a free program by obtaining a

restrictive license from a patent holder.  Therefore, we insist that

any patent license obtained for a version of the library must be

consistent with the full freedom of use specified in this license.

  Most GNU software, including some libraries, is covered by the

ordinary GNU General Public License.  This license, the GNU Lesser

General Public License, applies to certain designated libraries, and

is quite different from the ordinary General Public License.  We use

this license for certain libraries in order to permit linking those

libraries into non-free programs.

  When a program is linked with a library, whether statically or using

a shared library, the combination of the two is legally speaking a

combined work, a derivative of the original library.  The ordinary

General Public License therefore permits such linking only if the

entire combination fits its criteria of freedom.  The Lesser General

Public License permits more lax criteria for linking other code with

the library.

  We call this license the "Lesser" General Public License because it

does Less to protect the user's freedom than the ordinary General

Public License.  It also provides other free software developers Less

of an advantage over competing non-free programs.  These disadvantages

are the reason we use the ordinary General Public License for many
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libraries.  However, the Lesser license provides advantages in certain

special circumstances.

  For example, on rare occasions, there may be a special need to

encourage the widest possible use of a certain library, so that it becomes

a de-facto standard.  To achieve this, non-free programs must be

allowed to use the library.  A more frequent case is that a free

library does the same job as widely used non-free libraries.  In this

case, there is little to gain by limiting the free library to free

software only, so we use the Lesser General Public License.

  In other cases, permission to use a particular library in non-free

programs enables a greater number of people to use a large body of

free software.  For example, permission to use the GNU C Library in

non-free programs enables many more people to use the whole GNU

operating system, as well as its variant, the GNU/Linux operating

system.

  Although the Lesser General Public License is Less protective of the

users' freedom, it does ensure that the user of a program that is

linked with the Library has the freedom and the wherewithal to run

that program using a modified version of the Library.

  The precise terms and conditions for copying, distribution and

modification follow.  Pay close attention to the difference between a

"work based on the library" and a "work that uses the library".  The

former contains code derived from the library, whereas the latter must

be combined with the library in order to run.
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  GNU LESSER GENERAL PUBLIC LICENSE

   TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

  0. This License Agreement applies to any software library or other

program which contains a notice placed by the copyright holder or

other authorized party saying it may be distributed under the terms of

this Lesser General Public License (also called "this License").

Each licensee is addressed as "you".

  A "library" means a collection of software functions and/or data

prepared so as to be conveniently linked with application programs

(which use some of those functions and data) to form executables.

  The "Library", below, refers to any such software library or work

which has been distributed under these terms.  A "work based on the

Library" means either the Library or any derivative work under

copyright law: that is to say, a work containing the Library or a

portion of it, either verbatim or with modifications and/or translated

straightforwardly into another language.  (Hereinafter, translation is

included without limitation in the term "modification".)

  "Source code" for a work means the preferred form of the work for

making modifications to it.  For a library, complete source code means

all the source code for all modules it contains, plus any associated

interface definition files, plus the scripts used to control compilation

and installation of the library.
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  Activities other than copying, distribution and modification are not

covered by this License; they are outside its scope.  The act of

running a program using the Library is not restricted, and output from

such a program is covered only if its contents constitute a work based

on the Library (independent of the use of the Library in a tool for

writing it).  Whether that is true depends on what the Library does

and what the program that uses the Library does.

  

  1. You may copy and distribute verbatim copies of the Library's

complete source code as you receive it, in any medium, provided that

you conspicuously and appropriately publish on each copy an

appropriate copyright notice and disclaimer of warranty; keep intact

all the notices that refer to this License and to the absence of any

warranty; and distribute a copy of this License along with the

Library.

  You may charge a fee for the physical act of transferring a copy,

and you may at your option offer warranty protection in exchange for a

fee.
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  2. You may modify your copy or copies of the Library or any portion

of it, thus forming a work based on the Library, and copy and

distribute such modifications or work under the terms of Section 1

above, provided that you also meet all of these conditions:

    a) The modified work must itself be a software library.

    b) You must cause the files modified to carry prominent notices

    stating that you changed the files and the date of any change.

    c) You must cause the whole of the work to be licensed at no

    charge to all third parties under the terms of this License.

    d) If a facility in the modified Library refers to a function or a

    table of data to be supplied by an application program that uses

    the facility, other than as an argument passed when the facility

    is invoked, then you must make a good faith effort to ensure that,

    in the event an application does not supply such function or

    table, the facility still operates, and performs whatever part of

    its purpose remains meaningful.

    (For example, a function in a library to compute square roots has

    a purpose that is entirely well-defined independent of the

    application.  Therefore, Subsection 2d requires that any

    application-supplied function or table used by this function must

    be optional: if the application does not supply it, the square

    root function must still compute square roots.)
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These requirements apply to the modified work as a whole.  If

identifiable sections of that work are not derived from the Library,

and can be reasonably considered independent and separate works in

themselves, then this License, and its terms, do not apply to those

sections when you distribute them as separate works.  But when you

distribute the same sections as part of a whole which is a work based

on the Library, the distribution of the whole must be on the terms of

this License, whose permissions for other licensees extend to the

entire whole, and thus to each and every part regardless of who wrote

it.

Thus, it is not the intent of this section to claim rights or contest

your rights to work written entirely by you; rather, the intent is to

exercise the right to control the distribution of derivative or

collective works based on the Library.

In addition, mere aggregation of another work not based on the Library

with the Library (or with a work based on the Library) on a volume of

a storage or distribution medium does not bring the other work under

the scope of this License.

  3. You may opt to apply the terms of the ordinary GNU General Public

License instead of this License to a given copy of the Library.  To do

this, you must alter all the notices that refer to this License, so

that they refer to the ordinary GNU General Public License, version 2,

instead of to this License.  (If a newer version than version 2 of the

ordinary GNU General Public License has appeared, then you can specify
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that version instead if you wish.)  Do not make any other change in

these notices.
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  Once this change is made in a given copy, it is irreversible for

that copy, so the ordinary GNU General Public License applies to all

subsequent copies and derivative works made from that copy.

  This option is useful when you wish to copy part of the code of

the Library into a program that is not a library.

  4. You may copy and distribute the Library (or a portion or

derivative of it, under Section 2) in object code or executable form

under the terms of Sections 1 and 2 above provided that you accompany

it with the complete corresponding machine-readable source code, which

must be distributed under the terms of Sections 1 and 2 above on a

medium customarily used for software interchange.

  If distribution of object code is made by offering access to copy

from a designated place, then offering equivalent access to copy the

source code from the same place satisfies the requirement to

distribute the source code, even though third parties are not

compelled to copy the source along with the object code.

  5. A program that contains no derivative of any portion of the

Library, but is designed to work with the Library by being compiled or

linked with it, is called a "work that uses the Library".  Such a

work, in isolation, is not a derivative work of the Library, and

therefore falls outside the scope of this License.

  However, linking a "work that uses the Library" with the Library
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creates an executable that is a derivative of the Library (because it

contains portions of the Library), rather than a "work that uses the

library".  The executable is therefore covered by this License.

Section 6 states terms for distribution of such executables.

  When a "work that uses the Library" uses material from a header file

that is part of the Library, the object code for the work may be a

derivative work of the Library even though the source code is not.

Whether this is true is especially significant if the work can be

linked without the Library, or if the work is itself a library.  The

threshold for this to be true is not precisely defined by law.

  If such an object file uses only numerical parameters, data

structure layouts and accessors, and small macros and small inline

functions (ten lines or less in length), then the use of the object

file is unrestricted, regardless of whether it is legally a derivative

work.  (Executables containing this object code plus portions of the

Library will still fall under Section 6.)

  Otherwise, if the work is a derivative of the Library, you may

distribute the object code for the work under the terms of Section 6.

Any executables containing that work also fall under Section 6,

whether or not they are linked directly with the Library itself.
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  6. As an exception to the Sections above, you may also combine or

link a "work that uses the Library" with the Library to produce a

work containing portions of the Library, and distribute that work

under terms of your choice, provided that the terms permit

modification of the work for the customer's own use and reverse

engineering for debugging such modifications.

  You must give prominent notice with each copy of the work that the

Library is used in it and that the Library and its use are covered by

this License.  You must supply a copy of this License.  If the work

during execution displays copyright notices, you must include the

copyright notice for the Library among them, as well as a reference

directing the user to the copy of this License.  Also, you must do one

of these things:

    a) Accompany the work with the complete corresponding

    machine-readable source code for the Library including whatever

    changes were used in the work (which must be distributed under

    Sections 1 and 2 above); and, if the work is an executable linked

    with the Library, with the complete machine-readable "work that

    uses the Library", as object code and/or source code, so that the

    user can modify the Library and then relink to produce a modified

    executable containing the modified Library.  (It is understood

    that the user who changes the contents of definitions files in the

    Library will not necessarily be able to recompile the application

    to use the modified definitions.)
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    b) Use a suitable shared library mechanism for linking with the

    Library.  A suitable mechanism is one that (1) uses at run time a

    copy of the library already present on the user's computer system,

    rather than copying library functions into the executable, and (2)

    will operate properly with a modified version of the library, if

    the user installs one, as long as the modified version is

    interface-compatible with the version that the work was made with.

    c) Accompany the work with a written offer, valid for at

    least three years, to give the same user the materials

    specified in Subsection 6a, above, for a charge no more

    than the cost of performing this distribution.

    d) If distribution of the work is made by offering access to copy

    from a designated place, offer equivalent access to copy the above

    specified materials from the same place.

    e) Verify that the user has already received a copy of these

    materials or that you have already sent this user a copy.

  For an executable, the required form of the "work that uses the

Library" must include any data and utility programs needed for

reproducing the executable from it.  However, as a special exception,

the materials to be distributed need not include anything that is

normally distributed (in either source or binary form) with the major

components (compiler, kernel, and so on) of the operating system on

which the executable runs, unless that component itself accompanies

the executable.
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  It may happen that this requirement contradicts the license

restrictions of other proprietary libraries that do not normally

accompany the operating system.  Such a contradiction means you cannot

use both them and the Library together in an executable that you

distribute.
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  7. You may place library facilities that are a work based on the

Library side-by-side in a single library together with other library

facilities not covered by this License, and distribute such a combined

library, provided that the separate distribution of the work based on

the Library and of the other library facilities is otherwise

permitted, and provided that you do these two things:

    a) Accompany the combined library with a copy of the same work

    based on the Library, uncombined with any other library

    facilities.  This must be distributed under the terms of the

    Sections above.

    b) Give prominent notice with the combined library of the fact

    that part of it is a work based on the Library, and explaining

    where to find the accompanying uncombined form of the same work.

  8. You may not copy, modify, sublicense, link with, or distribute

the Library except as expressly provided under this License.  Any

attempt otherwise to copy, modify, sublicense, link with, or

distribute the Library is void, and will automatically terminate your

rights under this License.  However, parties who have received copies,

or rights, from you under this License will not have their licenses

terminated so long as such parties remain in full compliance.

  9. You are not required to accept this License, since you have not

signed it.  However, nothing else grants you permission to modify or

distribute the Library or its derivative works.  These actions are
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prohibited by law if you do not accept this License.  Therefore, by

modifying or distributing the Library (or any work based on the

Library), you indicate your acceptance of this License to do so, and

all its terms and conditions for copying, distributing or modifying

the Library or works based on it.

  10. Each time you redistribute the Library (or any work based on the

Library), the recipient automatically receives a license from the

original licensor to copy, distribute, link with or modify the Library

subject to these terms and conditions.  You may not impose any further

restrictions on the recipients' exercise of the rights granted herein.

You are not responsible for enforcing compliance by third parties with

this License.
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  11. If, as a consequence of a court judgment or allegation of patent

infringement or for any other reason (not limited to patent issues),

conditions are imposed on you (whether by court order, agreement or

otherwise) that contradict the conditions of this License, they do not

excuse you from the conditions of this License.  If you cannot

distribute so as to satisfy simultaneously your obligations under this

License and any other pertinent obligations, then as a consequence you

may not distribute the Library at all.  For example, if a patent

license would not permit royalty-free redistribution of the Library by

all those who receive copies directly or indirectly through you, then

the only way you could satisfy both it and this License would be to

refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any

particular circumstance, the balance of the section is intended to apply,

and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any

patents or other property right claims or to contest validity of any

such claims; this section has the sole purpose of protecting the

integrity of the free software distribution system which is

implemented by public license practices.  Many people have made

generous contributions to the wide range of software distributed

through that system in reliance on consistent application of that

system; it is up to the author/donor to decide if he or she is willing

to distribute software through any other system and a licensee cannot

impose that choice.
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This section is intended to make thoroughly clear what is believed to

be a consequence of the rest of this License.

  12. If the distribution and/or use of the Library is restricted in

certain countries either by patents or by copyrighted interfaces, the

original copyright holder who places the Library under this License may add

an explicit geographical distribution limitation excluding those countries,

so that distribution is permitted only in or among countries not thus

excluded.  In such case, this License incorporates the limitation as if

written in the body of this License.

  13. The Free Software Foundation may publish revised and/or new

versions of the Lesser General Public License from time to time.

Such new versions will be similar in spirit to the present version,

but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number.  If the Library

specifies a version number of this License which applies to it and

"any later version", you have the option of following the terms and

conditions either of that version or of any later version published by

the Free Software Foundation.  If the Library does not specify a

license version number, you may choose any version ever published by

the Free Software Foundation.
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  14. If you wish to incorporate parts of the Library into other free

programs whose distribution conditions are incompatible with these,

write to the author to ask for permission.  For software which is

copyrighted by the Free Software Foundation, write to the Free

Software Foundation; we sometimes make exceptions for this.  Our

decision will be guided by the two goals of preserving the free status

of all derivatives of our free software and of promoting the sharing

and reuse of software generally.

    NO WARRANTY

  15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO

WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.

EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR

OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY

KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE

LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME

THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

  16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN

WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY

AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU

FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR

CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE

LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
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RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A

FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF

SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH

DAMAGES.

     END OF TERMS AND CONDITIONS
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           How to Apply These Terms to Your New Libraries

  If you develop a new library, and you want it to be of the greatest

possible use to the public, we recommend making it free software that

everyone can redistribute and change.  You can do so by permitting

redistribution under these terms (or, alternatively, under the terms of the

ordinary General Public License).

  To apply these terms, attach the following notices to the library.  It is

safest to attach them to the start of each source file to most effectively

convey the exclusion of warranty; and each file should have at least the

"copyright" line and a pointer to where the full notice is found.

    <one line to give the library's name and a brief idea of what it does.>

    Copyright (C) <year>  <name of author>

    This library is free software; you can redistribute it and/or

    modify it under the terms of the GNU Lesser General Public

    License as published by the Free Software Foundation; either

    version 2.1 of the License, or (at your option) any later version.

    This library is distributed in the hope that it will be useful,

    but WITHOUT ANY WARRANTY; without even the implied warranty of

    MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU

    Lesser General Public License for more details.

    You should have received a copy of the GNU Lesser General Public
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    License along with this library; if not, write to the Free Software

    Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA  02110-1301  USA

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your

school, if any, to sign a "copyright disclaimer" for the library, if

necessary.  Here is a sample; alter the names:

  Yoyodyne, Inc., hereby disclaims all copyright interest in the

  library `Frob' (a library for tweaking knobs) written by James Random Hacker.

  <signature of Ty Coon>, 1 April 1990

  Ty Coon, President of Vice

That's all there is to it!
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